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2 Introducing the SMAC

The SMAC isincorporated into the Freescale BeeKit Wireless Connectivity Toolkit. Theincorporation of
SMAC into BeeKit makesit easier for users to employ and customize the SMAC. BeeKit generates the
project files and the project folder structure has changed from previous SMAC versions. Libraries are no
longer used, everything in aproject isin source code, and BeeKit generates a single target per project.
Every BeeKit generated project runs transparently with CodeWarrior Special Edition

To use any of the existing applications available in SMAC, users must first generate the applications as
projects in a BeeKit solution.

For more information about BeeKit, and BeeKit Projects and Solutions, refer to the BeeKit Wireless
Connectivity Toolkit User’s Guide (BKWCTKUG) and the BeeKit on-line help.
2.1  Supported Hardware

SMAC contains targets for the following Freescale hardware:
* Axiom-0308 with MC13192 RF Daughter Card

* 13192-SARD
« 13192-EVB
» 13213-NCB
* 13213-SRB

*  Axiom-0308 with the MC1320x RF Daughter Card

The example provided in this section uses the Sensor Reference Board (SRB) as the hardware. Figure 1
shows the SRB after it was removed from its plastic case.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1

2 Freescale Semiconductor



Accelerometer i | MC1321x

AEEE

A1 : ‘ bk

Buzzer

USB
- fren) |;“Iil |
w Do ' D) gl Mg
oM . @
= TR = 23 T S = UL S = I S = BT
DC Power

S100
Power Switch  Reset SW1 SW2 SW3 Sw4

Figure 1. SRB Connectors, Buttons, Switches, and LEDs

2.2 SMAC Software

Be sure to download the latest version of the SMAC which is part of BeeKit, from the Freescale ZigBee
web page at www.freescale.com/zigbee. Section 1, “Introduction” lists the currently available SMAC
demonstration applications. Refer to the release notes for more information.
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2.3  Generating an Application in BeeKit

This section shows how to generate an SMAC demonstration application using BeeKit.
1. Launch the BeeKit GUI and the BeeKit main window appears as shown in Figure 2.

Souton  Project e
H= R NI

Start Page | Property List|

o ———————.

TotalTestd.bksin 1 a8
To start developing a solution using BeeKit Select "File->New project’, or press "Create: New Project " inthe
"Recent Salutions" window.

2
Selectthe type of project and define the name and directory location.
For Example:

SelectaWireless UART to make a Wireless UART project,

To add mutiple projects to the same solution, select "Solution->Add project” o fight click on the solution narme in
the Solution explorer and select "Add project”

(Add muliple projects to the same solution ifyou are creating several applications )

For Example:

‘Adding ancther Wireless UART to the solution makes sense ifyou have two diferenttargets
hardware because you need ane projecrfor ane specifictarget hardware and another projectfor
the othertarget hardware

4
All components have propetties that can be modifed, o you can customize your applications
Vour can also add extra componerts

Selectwhether the application will use security, on the air programming (OTAP), define the OTAP Default D and
which channel wil be allowed for network formation

5

To prepare your solution for compiling and debugging you rmust export it This will create aworkspace with allthe
Open Solution files, an XML projectfile and property changes needed for each projectin the Solution
Create: New Project Select"Solution->Export Solution’ to export v

el on]

Solution cosed TatalTestd'

Figure 2. BeeKit Graphical User Interface

2. Select SMAC Codebase as shown in Figure 3.

Freescale BeeKit

Ei . Broj p
Proct... a2
»
e
To stert develaping a salufion using Beekit Select "File->New praject’, or press "Create: New Project. in the
"Recent Solufions" window.
2
Select he type of project and
Fanbxampls Browse For Folder
SelectaWireless UAH  solct Codebase ocation
Example: CProgram Fle|FreescalelCodebases|Codebase
T add muliple projects to th S 3 Codebases A e solution name in
the Solution explorer and seld (2 Beek Codsbase
(Add multple projects o he o ® Ca SACSD
For Example & 3 cwlorhCizvs8
@ ([ sMAcd.1c
Adding anather Wirele & O Test oo o et
hardware because ol ® 0 Zobee = Jrojectfor
the other target hardwe] {2 Frontline Test System It
(S
1 & 3 Google
All companents have proper % ) HhvAT CD Wrkting izard
Your can also add exra cam| © rEProxy
® ) EGL
Selectwhether the applicatio ® ) Insalshied Inseallation Information o pPoetautioan
which channel vill be allowed) — = %
5
To prepare your solution for allthe
Open Salfion files, an XML project ile and property changes needed for each project n the Salufian
Create:  NewProiect, Select"Solufion->Export Solufion” to export v
| Evor it gutput |

Solution closed TatalTestd"

Figure 3. selecting SMAC Codebase

In BeeKit, a Codebase is a set of files and rules that permit users to generate the final applications. This
step isimportant, because the SMAC Codebase is different than the Codebase of MAC and BeeStack.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1

4 Freescale Semiconductor



PR 4

3. Create anew project as shown in Figure 4.

New Project

| Project types:
- SMAC
My Solutian 0
[=- Other Project Types Lightinig Dema - Ceritroller
‘... Solutions Lighting Dema - Device
OTAP Programmer
PER Test Aix
PER Test TX
Flange Demo Pluz Rk
Fange Demo Plus Tk
Fepeater
Simple PTC
Test Mode
Wwireless UART
?I'.I'emplate application with SMAC and Platform components.
Code Base Version: 01.00 D
Froject Mame: |Generic Application |
Solution Mame: |SMAEEvaIuation1 |
Location: |D:\Pr0files\My Documents | D
[ ak, ] [ Cancel ]

Figure 4. Creating a new project

If users create anew project and there is not aan existing solution, then users are also creating a solution.
The solution must have a name. Specify aname for the solution.

4. Add other required projects for the evaluation as shown in Figure 5.

Genri LE;‘ Export Solution. ..

o[ 5MA 5
[ Plat

= * Expart Properties...
S Import Properties...
Yalidate Solution. ..

Upgrade solution. .,

Add Project. .. |

I t Projs
AT Add Project

Properties...

Expand All

Collapse Al

Figure 5. Adding a New Project to a Existing Solution

5. Modify the project properties as shown in Table 1.
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Table 1. Software Component Properties

Component Property Description
SMAC Security Enabled | Enables the security Module to automatically encrypt the information sent
and received.

OTAP Enabled |Enables the OTAP Module to allow over the air programming of the
application

Promiscuous Mode | If set to true, the SMAC Code Bytes are not sent prior to the message.
OTAP Default ID | This is the default ID for the device.
Security Type This is the security engine used if the security enabled property is true.
Currently, only the SIMPLE_XOR is implemented.
PLM Target hardware | Allows board selection.
LCD Enabled Includes support for LCDs.

Default SCI Port | Selects the SCI port. Freescale ZigBee boards usually have SCI Port 1
connected to a DB9 connector and SCI port 2 connected to a USB
connector.

App Default Channel | Default starting channel in the application.

Output Power

Initial power output configuration.

Users must now validate the solution as shown in Figure 6.

Export Solution...

‘
W75

Export Properties. ..

Impork Properties. ..

Walidate Solution,, . |

Walidate Solution b

Add Project...

¢ T o

Import Project...
Properties...

Expand All

Collapse Al

Figure 6. Validating a Solution

Users must now export the solution as shown in Figure 7.

[y Export Solution. ..
| 1

Export Solution

Source files is copied from codebase ko disk.,

| Validate Solution,..

ﬁ Upgrade solution. ..

Add Project. ..

Imnport Project.. .
Properties...

Expand Al
Collapse all

Figure 7. Exporting a Solution
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2.4 Loading Applications Into a Board Using the BDM

After exporting from BeeKit, the projects are generated as a . xm1 file. Perform the following tasksto load
the application to aboard. This example uses the Basic PER Test.

1. Asshown in Figure 8, import the PER Rx.xml file, then save the project as PER Rx.mcp.

Look in: | £ PER TestRix -] & @ o B
R

nome: [PER Test o Toon

e )

Figure 8. Importing a BeeKit .xml File

2. Compilethe project by clicking the Compile button (Figure 9) which islocated at the top of the
Project Window as shown in Figure 10.

b

Figure 9. Compile Button

=l

PEr rx.mcp I

[ Pie Fos @Ry &5

¥ | Fie | Code | Data |4
¥ =-E3Libs

3 R ansiizlib
¥ =53 Shared

¥ w1 SMAC
@ [+ diivers
@ EEIPER_AX
¢ {0 pm
¥ €3 5ources
'3 -l smac_per_m.c
-Jl smac_per_rwh
Ml derivative.h
[l Startd2.c

b i

£ R K
Ccoooooooooooooo

EYEYERCR TR R EN EY C C ER TR CR CY EY

Figure 10. New Project Window
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The structure of the project window displays various group files as follows:
* Libs— ANSI standard libraries are included
» Shared — Inthis group, the SMAC and the platform (PLM) source files are included.
* PER RX — Thisgroup contains the actual application sourcefilesaswell asthelinker file (.prm).

NOTE

Because of theintegration into BeeKit, thereisonly onetarget, no svAc. lib
or Target. lib files, and no subprojects. This allows the use of a Special
Edition license of CodeWarrior to transparently compile the projects.

The IDE builds the target if required and provides information messages, reports errors, and displays
warnings as needed.

3. If no errors are encountered from the build process, connect the BDM to the target as shown in
Figure 11.

The blue LED on the P& E Multilink turns on if the connection to the PC is functioning.
Theyellow LED on the P& E Multilink turns on if the cable is properly connected to the target.

Figure 11. P&E Multilink Connected to an SRB
4. Click the Debug/Download button (Figure 12) which islocated at the top of the PErR Rx.mcp Project
Window (Figure 10).

£

Figure 12. Download Button

If the connection to the USB BDM debugger isin place and the polarity to the BDM interfaceis
correct, the debugger triesto download the binary to the target. At that point, the |CD-Connection
Manager window (Figure 13) appears where users have the ability to select the target interface.
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ICD - Connection Manager il

Y'ou have selected to display this dialog on startup. Specify cummunlc:ﬂtluns
parameters and click OkK_

—Connection part and Interface Type

Interface: IUSE HCS028/HCST2 Multilink, - USE Part j Add LPT Port
Refrezh List

Fart; IF'&E HCS03/HCS12 Multiink on USB1 [Mame=PE316338) [ﬂutudelectedj

Interface Detected Firruare YWersion : Socket Programming Adapter Settings ... |

—Target CRPU Informatior
CFU: HCS508 Processor - Autodetect
MCL reset line: MECL Yaoltage:

—Feset Delay
[~ Delay after Reset and befare communicating to target for I 0 milizeconds [decimal].
¥ ‘hen initiating a debugger reset, the MCL Reset Pin should be used [else use a debug module reset)

rCuclone Pro Power Relay Control - [Yoltage - Power-Out Jack}
[T Use Coclone Pro relays Feaulatan Dutput Yaltage Fawer Dawn [Delau I 250 &

[ Power afftarget upaty saftware ext |5u' -.-I Fovwer Up Delay I 200 ms

Lcaonnect | Hotsync | Abort

Figure 13. ICD Connection Manager Window (IDE)

5. ThelCD Connection Manager window (Figure 13) shows the available connections to the
debugger. Select the correct Interface and Port using the appropriate drop down menus and click
the Connect button.

6. Asshownin Figure 14, another window may appear with arequest to erase the flash memory data
on the target. Click the Y es button to Flash the board again.

M Erase and Program Flash? Jgﬂ

Load image contains flash memory data. Erase and Program flash?

o Ji= ] ow |

Figure 14. Erase and Program Flash Window

7. After the flash memory is programmed, the Default/Main debugger window appears as shown in
Figure 15.
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True-Time Simulator & Real-Time Debugger F:\C¥5%smac\SMAC4.1b%508" apps'PER test',PER TX'3.1\P&E_FCS.ini =8 lﬂ
File Wiew Run MukilinkCyclonePra Component  Command  Window  Help

Djel@| (e 2w oz z]e]el4] 9]

R 3 = JREE
FACYShamachSMACA. 1045 D8\ argetiaichStartD8 o [Line: 287 _Startup
3) call main; d d
called from: PRESTART-code generated by the Linker LDA  _startupData.flags ]
bt BIT #0x02

#ifdef ELF OBJECT FILE FORMAT ENE *+6 raha = 0x18B3
£ in HIWARE £ I LDHx #0x0695
#endif TXS
for (;;) {E /* forever: initialize the program; call the root-procedure ¥/ B3R *-121 ;abs = Ox1G34 j
if [!{_startupData. £lagssSTARTUF_FLAGS_NOT INIT_SP)) (&

/% initialize the stack pointer */ =] REgister =10l x|

INIT SP_FROM STARTUP_DESC(): | == 1=
= s [o
kI Al [ 0 se[ 7
|| s [6s seews [imic
- PC (1847
_Gtartup ()
e

Auto

0000 48 00 00 00 00 00 00 00 H.. ﬂ
0008 17 00 00 00 FL 00 00 0O

0010 00 00 00 00 00 00 00 00
0018 00 04 00 00 €O 00 00 00
0020 00 04 00 00 CO 00 00 00

B patail 1l -|0] || |00z 04 00 oo 20 00 o0 00 0D

,7,— = 0030 00 00 00 00 00 00 00 0O
Start03.c Auto [ Symb | Global GeEL EE S S s s

startuplata <%9> _tagitartup 0040 00 00 00 00 10 00 00 0O
__SEG_END_S8TACE <0> array[0] of unsigned char 0048 44 00 00 0L 00 CO AF 00

0050 00 01 00 00 00 00 00 00
0053 00 00 00 80 00 00 00 00
0060 00 00 00 00 00 00 00 00
0068 00 00 00 00 00 00 00 0O
0070 00 00 00 00 00 00 00 0O

—loix

_Startup Auto [ Symb Local X .
I0 registers loaded for MC9305GTE0 from C:\Program Files‘\Freescale)
Startup command file does not exist.
Preload command file does not exist. _I
Poatload command file does not exist.
Target Ready
MCO Dewvice Selection has been changed.
in| -
K1 | H
Executes one source instruction |Butomatic {triggers, braskpoints, watchpoints, and trace possible) [9s8GTED [ICD [Target Ready

Figure 15. Hiwave Debugger Main Window

8. To run the program, users have two options:
a) Disconnect the BDM cable from the board and push the Reset button on the board once.

b) Leavethe BDM cable connected and click on the Run button in the Hiwave Debugger Main
window (Figure 16).

1| &

R EEEERRE]

R

Figure 16. Hiwave Debugger (Run Button)

The loading process described in this section appliesto all currently available SMAC applications.
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NOTE

If using the Freescale Embedded Bootloader instead of the BDM to load the
SMAC applications, refer to the 802.15.4/ZigBee Embedded Bootloader
Reference Manual (802154EBRM) for moreinformation about how to load
bootloader enabled S19 files. The bootloader S19 files are built when
compiling a project that was generated in BeeKit with the Bootloader
property set to true. The S19 files are located in the bin folder of the mcp
directory and have the <project name>.s19 file name format.

2.5 IDE Considerations

SMAC does not currently support the device initialization feature of CodeWarrior. If a port to another
MCU isrequired, users must employ the MCUs supported in BeeKit or the generated project must be
ported manually.

3 Basic Packet Error Rate (PER) Test

3.1 Overview

The Basic Packet Error Rate (PER) test isaunidirectional test that sends 1000 packets from a transmitter
to areceiver all on asingle channel. The packet length is 18 bytes of data with 2 bytes of SMAC header
for atotal of 20 bytes of payload. The results of the packets received by the receiver can be monitored in
two ways:

* Using aPC and a USB connection
* In astandalone mode by reading the count on the LEDs on the board

Thistest allows for basic PER testing using a PC.

3.2 Loading the Packet Error Rate Application
Prior to loading the Packet Error Rate application, the following applications must be generated using
BeeKit using the steps shown in Section 2.3, “ Generating an Application in BeeKit”.

e PERTX

 PERRX

1. Opentheprer Tx.mcp file as shown in Figure 17. Load the PER TX application into one board as
shown in Section 2.4, “Loading Applications Into a Board Using the BDM”.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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3 D:\Program Files\Freescale\SMAC4. 2\508\apps\PER test\PER TX\3.1 =1

File Edit View Favorites Tools Help '
; Q- Q 3 F F SO search Folders | T3]~
: Address |23 D:\Program Files\Freescale\SMAC4. 21508 \apps|PER test\PER TX\3.1 s ﬂGD

Mame Size | Type Date Modified
File and Folder Tasks ¥ bin File Folder

|[CIPER_TX_Data File Falder
Other Places ¥ @ C_Layout.hwl 1KB HWL File
= Defautt.mem 1KE  MEM File ;
Details ¥ _:'a P&E_FCS.ini 4KB Configuration Settings 7
.}P'&E_ICD‘\I'H 2KB Configuration Settings 7 :
PER TX.mcp 795KE  CodeWarrior Project 8/7/2006 5:02PM

Figure 17. PER TX MCP File Location

3.3 Changing the Frequency of the Board

In thereisan interference issue, or users need to simultaneously run more than one demonstration, the RF
channel can be changed by pressing SW2 on both of the boards. Only four (4) frequencies are available:

* 2405GHz

 2430GHz
e 2455GHz
* 2480 GHz

For example, out of reset, LED4 is set to indicate that the first channel (2.405 GHz) isbeing used. To
change channels, press SW2 on board one. The buzzer chirps and LED3 is set to indicate that the second
channel (2.430 GHz) is now being used on board one. Press SW2 on board two which will set LED3 and
thus match channels with board one.

Both boards are required to be on the same channel to work correctly. If communication problems exist,
it is possible that one of the boardsis on a different channel. Reset both boards to ensure that both are on
the first channel (2.405 GHz), or push button SW2 until both boards LEDs match.

NOTE

There is no reason to change channels unless the system encounters an
interference issue or users want to simultaneously run multiple
demonstrations.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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3.4  Setting Up the UART/USB Virtual Com Port
Figure 18 shows the default SMAC RS-232 settings.

Part Settings I
Bitz per zecond: |384DD j
[rata bits: IE ll
Parity: INune ;I
Stop bits: I'I LI
Flovs contral: -

Restore Defaults I

Ok I Cancel I Apply |

Figure 18. Default SMAC RS-232 Setting

1. UseaPC terminal program and set the correct baud rate, data bits, parity, COM port, and flow

control.
2. Inthe PC terminal program, set the propertiesin the optional settings as shown in Figure 19.
— ASCIl Sending

v Send line ends with line feeds

¥ Echo typed characters locally

Line delay: ID milliseconds.

Character delay: ID millizeconds.

— ASCIl Receiving

v | Append line feeds to incoming line ends
[ Force incoming data to 7-bit &5CI1

v ‘wrap lines that exceed terminal width

Ok I Cancel |

Figure 19. Additional Terminal program settings

3. Connect the PER RX radio to the PC with either a RS-232 cable or aUSB cable. If usingaUSB
cable, acorresponding USB driver isrequired. Thisdriver can be found on the CD in the hardware
kit or the CD imageisavailable from the Freescale ZigBee web site at www.freescal e.com/zigbee.

4. To check which COM port is being used by the USB, do the following:
a) Open the System Properties window using Start->Settings->Control Panel->System.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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b) Select the Hardware tab, and click the Device Manager button. The Device Manager window
appears as shown in Figure 20.

L, pevice Manager ]
J ackion Wiew “ = = | | EP |J |
@ Monitors ;I

\> tulkifunction adapters

[-E8 Network adapters

-4 PCMCTA adapters

B~ 5 Porks (COM & LPT)

. (y Communications Port (COML)

r;yf Communications Port (COMEZ)

“y‘ Freescale Zighee 302,15, 4 MAC COM Device (COMS)

& Printer Port (LPTL)

= SCSI and RAID controllers
System devices

el

Sound, video and game controllers

Universal Serial Bus controllars

I I |
Figure 20. COM Port Determination in Device Manager

#

#

c) Scroll tothePortslabel and expand thetree by clicking the“+” sign. Thisshowsthe COM ports
in the system.
d) Asshownin Figure 20, the COM Port chosen by the system istitled Freescale
ZigBee/802.15.4 MAC COM Device (COM5).
5. If the COM port chosen for Freescale Zigbee/802.15.4 MAC COM Device iSnot aport within Ports
1-10, then perform the following tasks:
a) Doubleclick onFreescale zigbeesg02.15.4 MAC COM Device inthe Device Manager window.
The Properties window appears.
b) Select the Port Settings tab, and then click on the Advanced button.
6. Go to the Com Port Number drop down menu and select a COM port between 1-10 that is not in
use.

3.5 Starting the PER Test

Ensure that both the PER-TX board and the PER-RX board are on the desired channel as described in
Section 3.3, “Changing the Frequency of the Board”. The PER-TX board and the PER-RX board are
asynchronous to each other which means that the PER-TX board does not know when the PER-RX board
ison. Users must place the PER-RX board into Listen Mode prior to setting the PER-TX board into
Transmit Packet Mode. If thisis done out of order, the reported packet error rate may be incorrect.

Press the Reset button on the PER-RX board. An Out of Reset or a Power Up message is echoed through
the RS-232 interface and displayed on the PC as shown in Figure 21. To place the PER-RX board into
Listen Mode, press SW1 on the PER-RX board. All four LEDs blink twice to indicate that the PER-RX
board isin Listen Mode and a message to indicate that the PER-RX board is listening is echoed to the

terminal as shown in Figure 22.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
Freescale Semiconductor

14



b -

#g Direct bo Com5 - HyperTerminal
File Edit Wiew Cal Transfer Help

Ri= @EJD

—————— SMAC R¥ PACKET TEST -—————-
SH1 - Start Test
52 - Change Channel

I iy

(Connected 0:00:18 Autodetect  3B400E-N-1 SCROLL |08

Figure 21. PER Power on Reset Message

#gDirect to Com5 - HyperTerminal L = ||:||1|

File Edit Wiew Call Transfer Help

SH1 - Start Test Al
SW2 - Change Channel

The RX radio is now listening. ..
Start the test by pressing SW1 on the TX radio

-

| | »

Connected 0:01:41 lutodetect  [3s400EMl  [SCROLL [CAPS oM [Captue | 4

Figure 22. Output to the PC (From Receiving Board When in Listen Mode)

The PER-TX board setup followsaprocedure similar to the PER-RX board setup. Placethe PER-TX board
on the same channel as the PER-RX board by pressing SW2. This ensures that the PER-TX board is on
the same channel as the PER-RX board as described in Section 3.3, “Changing the Frequency of the
Board”. Press SW1 on the PER-TX board to place the application into TX mode. The PER-TX application
turnson LEDs 1 through 4 in order to show that the PER-TX board isin Packet Transmit Mode and then
it beginsto transmit packets.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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3.6

Basic PER operation

Since the PER-TX board and the PER-RX board are on the same channel and the PER-RX board started
to listen before the PER-TX board sent any packets, the PER-RX board will toggle LED1 when a packet
isbeing received. Thenthe PER-TX board blinks LED1 on every packet that istransmitted. If both boards
are blinking, then both boards are on the same channel. If only the PER-TX board istoggling LED1, then
either the PER-RX board isnot in Listen Mode or it islistening to the wrong channel. If this occurs, reset
both boards and try the procedure again without switching channels. If a packet is received, the radio

echoes data to the PC through the UART connection as shown in Figure 23.

N represents the number of packets received

L isthe length of the packet

LQI isthe Link Quality Indicator (measured in dBm)

CRC indicatesif the Cyclical Redundancy Check (CRC) is good
Datais the hex formatted payload

N:980 L:18 LQI=-24 CRC=1 Data=000102030405060708098ABBACODBEAF1011
N:981 L:18 LQI=-24 CRC=1 Data=000102030405060708090A0BOCODOEAF1011
N:982 L:18 LQI=-24 CRC=1 Data=000102030405060708090A0BOCODOEAF1011
N:983 L:18 LQI=-24 CRC=1 Data=000102030405060708090ABBOCODOEAF1011
N:984 L:18 LQI=-24 CRC=1 Data=000102030405060708090ABBOCODOEAF1011
N:985 L:18 LQI=-24 CRC=1 Data=000162030405060708096A0BOCODGEOF1011
N:986 L:18 LQI=-24 CRC=1 Data=000162030465060708096A0BOCODGEOF1011
N:987 L:18 LQI=-24 CRC=1 Data=000162030405660708096N0BOCADGEAF1011
N:988 L:18 LQI=-24 CRC=1 Data=000162030405660708096N0BOCADGEAF1011
N:989 L:18 LQI=-24 CRC=1 Data=000102030405060708098ABBACODBEAF1011
N:990 L:18 LQI=-24 CRC=1 Data=000102030405060708090A0BOCODOEAF1011
N:991 L:18 LQI=-24 CRC=1 Data=000102030405060708090A0BOCODOEAF1011
N:992 L:18 LQI=-24 CRC=1 Data=000102030405060708090ABBOCODOEAF1011
N:993 L:18 LQI=-24 CRC=1 Data=000102030405060708090ABBOCODOEAF1011
N:994 L:18 LQI=-24 CRC=1 Data=000102030405060706090ABBOCODOEAF1011
N:995 L:18 LQI=-24 CRC=1 Data=000162030405060708096A0BOCODGEOF1011
N:996 L:18 LQI=-24 CRC=1 Data=000162030405660708096N0BOCADGEAF1011
N:997 L:18 LQI=-24 CRC=1 Data=000162030405660708096N0BOCADGEAF1011
N:998 L:18 LQI=-24 CRC=1 Data=000162030405660708096N0BOCODGEAF1A11
Good:  999/1006

Hal t

Figure 23. The UART output during PER test

When the PER-TX board isdone sending 1000 packets, the PER-TX board sends packets with the payload
“DONEDONE”. If the PER-RX board receives the “DONEDONE" packet, the application echoes the
total number of good packets received. The measured PER is echoed to the terminal in a999/1000 format.
Also, the PER value is echoed to the LEDs on the PER-RX board. For example, if the measured packet
error rate was 983/1000 then at the completion of the test, the value 1001b (9d), 1000b (8d), 0011b (3d)
will blink. This allows PER to be measured without the need for a PC.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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3.7 Restarting the Basic Packet Error Rate Application

The first task to perform for arestart is to reset both boards and repeat the procedures as shown in
Section 3.5, “ Starting the PER Test”. However, this may result in resetting the RF channel back to
Channel 0 (2.405 GHz). If the channel was changed from the default Channel 0 and the test needs to be
repeated on the changed channel, press SW1 on the PER-RX board and then press SW1 on the PER-TX
board to repeat the test. If users need to choose a different channel, then use SW2 to change the channel
on both the PER-TX board and PER-RX board as described in Section 3.3, “ Changing the Frequency of
the Board”.

4  Wireless UART Demonstration

The Wireless UART application allows the Freescale ZigBee family of boards to communicate at
typematic rates from one board to another over RS-232 cables or USB virtual com ports.

The following is asimplified example and the code as it exists cannot be used as a cable replacement. If
cable replacement is the goal, then queues, buffers, and other constructs must be added to increase the
reliability and efficiency of this demonstration.

Prior to loading the Wireless UART application, the application must be generated using BeeKit using the
steps shown in Section 2.3, “ Generating an Application in BeeKit”.

1. Connect the boardsto their respective ports and select a Com Port using the Device Manager as
shown in Section 3.4, “ Setting Up the UART/USB Virtual Com Port”. Once the Com Ports are
determined, open the Com Port with the settings as shown in Figure 18.

2. Openthewireless vart.mcp file as shown in Figure 24.

) D:\Program Files\Freescale\SMAC4.2\S08\apps\Wireless Uart\3. 1 =1
File Edit View Favorites Tools Help #
Q Back ~ é ? g' ﬂ( /.- ! Search Folders mv

Address ([Z) D:\Program Files\Freescale\SMAC4, 21508 \apps\Wircless Uart!3. 1 et a Go
Mame Size | Type Date Modified
File and Folder Tasks ¥ Cibin File Folder (742006 4:49 PM

)Wireless_Uart_Data File Folder PM
Other Places ¥ 2] C_Layout.hwl 1KB HWLFile

@Defau\t.mem 1KB MEMFile 06 12:22PM
Details ¥ _ﬁ P&E_FCS.hwe 0KB HWCFile 06 12:22PM
(= pae_Feshul 1KB HWL File 06 12:22PM
[&pae_Fes.in 4K8  Configuration Settings  8/3/2006 10:15 AM
_';'vPE«E_ICD.ini 2KB Configurstion Settings 73 06 12:22PM
'\"fi\ eless Uart.mcp 814KB CodeWarrior Project  8/3/2006 12:42PM

Figure 24. Wireless UART MCP File Location

3. Load the Wireless UART application into two boards as shown in Section 2.4, “Loading
Applications Into a Board Using the BDM”.

4. Reset both boards. The application’s Out of Reset text echoes awelcome message as shown in
Figure 25.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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“¢Direct to COM1 - HyperTerminal
Fie Edt View Cal Tranfer Hep

WEEERRE

Wireless Typematic leno

| y

{
Buodtet  FB0ENA  [SROL [ Juw [Catue [pinteho y

‘Connetted Dot
Figure 25. Wireless UART Reset UART Message

5. Once both boards are reset and proper RS-232 connectivity is established, type some charactersin
the HyperTermina Session (Board 1) window (Figure 26) and the typed message will appear on

the other PC’'s HyperTerminal Session (Board 2) window (Figure 27).

& Direct to Coms - HyperTerminal _ o (=] P
Fle Edi wiew call Transfer Help
Dl =& «ole

Hireless Typematic Demo

The lazy brown fox jumped over the moon..._

4|

Connected 0:00:21 [Adtodetect  [38400@ M1 [SCROLL  [CAPS [WOM  [Caprure  [Prnt eche o

Figure 26. Wireless UART Board 1 (Output to Board 2)

& Direct to COM1 - HyperTerminal =10] x|
File Edit Wiew Call Transfer Help
EE R
= |
Wireless Typematic Demo
The lazy brown fox jumped over the moon..._
4] i >
Connected 0:00:56 |auto detect (38400 8-H-1 = €APS oM [Caprure

Figure 27. Wireless UART Board 2 (Input from Board 1)
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Thisisatwo-way communication protocol where the boardswill retry their packets up to threetimesif an
acknowledgement is not received. This application highlights avery basic SMAC wireless UART
implementation and as already stated, becauseit isabasic demonstration application, it is not intended for
large file transfers.

5 Accelerometer Demonstration

The Accelerometer Demonstration application shows various uses of the Freescale X, Y, and Z axes
accelerometers. For a complete overview of the Accelerometer Demonstration application, see AN3232,
Accelerometer Demonstration With the 13213-SRB (Sensor Reference Board).

5.1 Loading the Accelerometer Application

1. Flashthe Accelerometer Demonstration into two boards. One board must be either a13192-SARD
or an SRB to provide the X, Y, and Z axes accelerometer data and the other board must have an
available UART and be able to connect to a PC. This example uses two SRBs.

2. |If users need to run the Accelerometer on different targets, those projects must be generated by
BeeKit as described in Section 2.3, “ Generating an Application in BeeKit”. Import the .xmi files
and generate the CodeWarrior .mcp project filesasdescribedin Section 2.4, “ Loading Applications
Into a Board Using the BDM”.

3. Download the appropriate target image by following the procedure in Section 2.4, “Loading
Applications Into a Board Using the BDM”, with the Accelerometer v3.mcp project.

5.2 Board Setup

To setup both boards for operation (transmit and receive), perform the steps shown in this section. See
Figure 1 for apicture of the SRB.

5.3 Board One Setup (PC_Radio Board)

1. Connect a SRB to the PC using the USB cable included in the kit.

2. Connect the USB bus to the USB hub. This provides power to the board through the USB bus.
Power on the board by setting the Power Switch (S100) to the ON position.

3. Pressthe Reset Button once. The LEDs are off, but the PC_Radio application isrunning and in
receive mode.

5.4 Board Two Setup (Accelerometer Board)

1. Connect 9 VDC power to DC power connector with the 9 VDC wall transformer included in the
kit. Power on the board by setting the Power Switch (S100) to the ON position. Another board
power option is to use the batteries which provides the advantage of true wireless operation (no
cables) and allows users to easily move and manipul ate the SRB.

2. Pressthe Reset Button once.

3. Pressbutton SW1 once and LED3 will momentarily flash to indicate Application Two is running
(Accelerometer Mode).

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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The Accelerometer application sends a ping packet to the PC_Radio every two seconds. Thisis
indicated on the Accelerometer Board by a blinking LED2.

The Accelerometer application detects when the Accelerometer Board is moved and quickly
toggles LED1, then sends a packet to the PC_Radio Board with an updated reading.

PC Setup

If the Evaluation Kit toolsare already installed, then users can run the Triax software by navigating
to the link using the Start menu.

From Windows, select Start->Programs->Freescale ZigBee->Test Tool->Triax.

a) If the Triax application does not exist, go to Step 3 to install it.

b) If the application isin the Start Menu, go to Step 8.

To run only the Triax application, insert the CD supplied with the kit into the PC CD-ROM drive.
If autorun is not enabled on the PC, locate the Autorun directory on the CD and run the

CDBrowser .exe file.

After launching the Evaluation Kit CD Browser, select Install/Uninstall.
Select the SMAC packet under Additional.

Run the installation and select the appropriate install folder.

Run the Triax.exe file from the selected install location on the PC hard drive.

The Triax application isset up to run on COM ports 1-10. To check which COM port isbeing used
by the USB, perform the following tasks:

a) Open the System Properties window by clicking on Start->Settings->Control Panel->System.

b) Select the Hardware tab, and click the Device Manager button. The Device Manager window
appears as shown in Figure 28.

c) Scroll tothe*Ports’ label and expand the tree by clicking the “+” sign to show the COM ports
in the system.

d) The COM Port selected by the system istitled Freescale ZigBee/802.15.4 MAC COM Device
(coms) as shown in Figure 28.

E, Device Manager - |EI|1|
J Action  Miew |J = = | | @ |J ol |

@ Manitars -]
Multifunction adapters

: Mebwork adapters

PCMCIA adapters

# Ports (COM 8 LPT)

néyf Comrunications Port (COM1)

¥ Communications Port (COmM2)

n;y? Freescale Zighee/502. 15,4 MAC COM Device (COMS)

- ' Printer Port (LPT1)

= 5C5I and RAID controllers

: = Sound, wideo and game controllers

+]- |3 System devices

-- Universal Serial Bus controllers -

I | I
Figure 28. COM Port Determination in Device Manager

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1

20

Freescale Semiconductor



10. If the COM port chosen for Freescale Zigbee/802.15.4 MAC COM Device iShot a port within Ports

5.6

1-10, then perform the following tasks:

a) Doubleclick on Freescale zigbee/802.15.4 MAC COM Device in the Device Manager window
and the Properties window will appear.

b) Select the Port Settings tab and then click the Advanced button.

¢) Go tothe Com Port Number drop down menu and select a COM port between 1-10 that is not
in use.

Verifying Operation

Check for the ping packet. The Accelerometer application sends a ping packet to the PC_Radio
every two (2) seconds asindicated by LED2. The Accelerometer Board quickly blinks LED2
indicating that the ping packet is sent. The PC_Radio receives the ping and toggles LED2 upon
reception. Once connectivity between the PC_Radio and the Accelerometer Board is verified, go
to Step 2.

To check if the Accelerometer Board is working, move the Accelerometer Board. LED1 blinks,
which indicates that the Accelerometer Board has detected movement.

With the default application, data that represents movement of the Accelerometer Board is sent to
the PC_Radio. When the PC_Radio receives this data, LED2 toggles.

Select the Raw Data applet from the Triax application. The Raw Data applet showsthe X, Y, and
Z axes A/D vaues as reported by the Accelerometer Board. When the board islaying flat, the raw
values should read approximately Og for both the X and Y axes. However, the Z axis should read
approximately 1g. As shown in Figure 29, when the Accelerometer Board is moved, the values of
the X, Y, and Z axes are updated on the Raw Data appl et.

Raw Data Demo i x|

Accelerometer Output in Volts Exit Raw Data

Accelerometer Reading in 8-bit AJD Counts [0-255]

Accelerometer Output converted into g's
-fxis Z-Axis

1.629 v 2.420 v

134 D 187 AD

0.098 g 0.967 g

1.5g mode was selected.

Figure 29. Raw Data Demonstration

NOTE

To improve accuracy of the accelerometer readings, refer to Section 5.7,
“Setting Up the Calibration Application”.

The Triax main window appears as shown in Figure 30.
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Figure 30. Triax Main Window

When the accel erometer ismoved, the Accelerometer Board sends datato the PC_Radio to update its data.
Dataisonly sent when it changes within a small tolerance.

The receiver receives these packets and updates its cached value of the accelerometer data. The PC
periodically sends acommand string through the USB to the PC_Radio that requests the accel erometer
data. Thisdataisinterpreted by the Triax software to enable severa applications and demonstrations.
Again, for acomplete overview of the accelerometer demonstration, see AN3232, Accelerometer
Demonstration With the 13213-SRB (Sensor Reference Board).

5.7  Setting Up the Calibration Application

In order to verify and visualize the calibration procedure, the Triax.exe PC GUI must be running, butitis
not required.
1. Pressthe Reset button on the PC_Radio Board once. (Out of reset, the PC application is running.)
2. Pressthe Reset button on the Accelerometer Board once.
3. Placethe Accelerometer Board on aflat surface. (component side up)
4

Press SW1 on the Accelerometer Board to advance the application to the Accelerometer Mode
(Application Two). LED3 momentarily lights to indicate that Application Two isrunning. The
Accelerometer Board sends out a ping packet every two (2) seconds and updates the data on the
XY Z Demo PC application each time the board is moved.

5. If thedatapointsfor the X, Y, and Z axes shown on the PC GUI are not near the origin of the graph,
then continue to Step 6.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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6

Press SW4 on the Accelerometer Board once until all LEDs arelit. This showsthat the calibration
is being performed.

Verify that the Accelerometer Board is calibrated by viewing the X, Y, and Z axes on the PC GUI.
The sguares on the display should be approximately at axis point 0,0. If the calibration is till
incorrect, repeat the calibration process until the data points are nominally at axis point 0,0.

To quit, exit the application in the GUI and press reset on both boards. Press SW1 on the
Accelerometer Board once to return to main application functionality.

Range Demonstration Plus

The Range Demonstration Plus application consists of two binary images:

The TX range demo plus application (TX_APP)
The RX range demo plus (RX_APP)

The TX_APP continuously transmits a packet at a certain rate and waits for an ACK packet from
the RX_APP.

These applications must be generated by BeeKit as shown in Section 2.3, “ Generating an
Application in BeeKit”. Import the .xm1 file and generate the .mcp file as described in Section 2.4,
“Loading Applications Into a Board Using the BDM”.

Download the appropriate target image by following the procedure shown in Section 2.4, “Loading
Applications Into aBoard Using the BDM” with the Range Demo Plus RX.mcp into one board and
Range Demo Plus TX.mcp into another board.

The TX_APP sends a packet with apayload of “ZigBee” to the RX_APP. If the RX_APPreceives
the “ZigBee” packet, LED1 toggles.

The Link Quality Indicator (LQI) is also read and the following indications apply:

— If the LQI isgreater than -40 dBm, the RX_APP turnson LEDs 2, 3, and 4 to indicate highest
LQI.

— If the LQI returns -60 through -40 dBm, the RX_APP turnson LEDs 2 and 3.

— If the LQI returns -80 though -60 dBm, the RX_APP turnson LED2.

— If the LQI reports <-88 dBm, the RX_APP leaves LEDs 2, 3, and 4 off.

Power ranges can be adjusted by modifying the SPEC_POWER, L1 POWER, L2_POWER, and
L3 POWER definesin the range_demo_plus_header.h header.

Once the RX_APP decodes the power range for the last packet, it formsan ACK packet with the decoded
power bin at the end of the ACK packet.

For astrong signal inthe L3_POWER range, the ack packet is“ACK3” whichisinterpreted by the
TX_APPto turn on the three LEDs on the TX_APP side.

For asignal inthe L2 POWER range, the ack packet is“ACK2” which isinterpreted by the
TX_APPto turn on thetwo LEDs on the TX_APP side.

For asignal inthe L1 POWER range, the ack packet is“ACK1” which isinterpreted by the
TX_APPto turn on the one LEDs on the TX_APP side.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1
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* For asignal inthe SPEC_POWER range, the ack packet is“ACKOQ” which isinterpreted by the
TX_APPto turn off the three LEDs on the TX_APP side.

The TX_APP receives the ACK packet and turns on the appropriate number of LEDs and toggles LED1.
In thisway, users can perform rough power characterizations by approximating the power received by the
RX_APP on either the RX_APP or the TX_APP board.

6.1 Range Demonstration

1. Reset both boards.

2. Out of reset, the TX_APP walksthrough LEDs 1 through 4 to indicate that it isatransmitter while
the RX_APP blinks all four LEDs twice. This allows users to know which is the transmitter and
which isthereceiver.

3. Because the boards are physically located close to each other, packets should be received by both
boards and LED1 should be toggling to indicate that packets are being received. LEDs 2 through
4 are on which indicates a strong signal because the boards are close to each other.

4. Asthe distance increases between the TX _APP and RX_APP boards, the LEDs should begin to
turn off one by one. When only LED1 is blinking, the radio should be operating at approximately
-88 dBm.

7 Lighting Demonstration

This section describes the Lighting Demonstration.
1. Thefollowing applications must be generated by BeeKit as described in Section 2.3, “ Generating
an Application in BeeKit”.
— Lighting Demo — Controller
— Lighting Demo — Device
2. Import both projects as described in Section 2.4, “Loading Applications Into a Board Using the
BDM”, and open them.

3. Download the appropriate target images by following the procedure as described in Section 2.4,
“Loading ApplicationsInto aBoard Using the BDM” with the Lighting_demo_device.mcp into one
board and Lighting_demo_controller.mcp into another board.

7.1  Lighting Controller Selection and Operation

This section demonstrates how the board loaded with the Lighting_demo_controller applicationisused as
the Lighting Controller.

Upon power-up or reset, any push button can be pressed and held to manually select an operating channel.
On power-up or reset, all LEDsflash for one (1) second to indicate that the board isaLighting Controller.
Next, the group number (i.e. SERNUM) LED isflashed on for one (1) second to identify the group. If the
channdl is selected manually, the respective push button is released and the channel LED flashes for one
(1) second. If channel selection is automatic, al LEDs are on while the unit searches for the clearest
channel. Oncethis channel is detected, the respective LED flashes on for one (1) second and initialization
of the board as a Lighting Controller is complete.
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To use the Lighting Controller, perform the following steps.

1. Press SW1 to wake the controller out of its very low-power mode (i.e. MCU in STOP3 and
MC1320x in Reset.)

2. The LEDscycle each time SW1 is pressed to select a desired remote board. If the push button
remains inactive for approximately four (4) seconds, the controller returns to the very low power
state.

3. Press SW2 to select the desired remote board's light (LED).

4. Press SW3 to toggle the destination remote on/off. Remember, the remote board is selected using
SW1 and the LED is selected using SW2.

5. The remote board acknowledges the toggle command and if received successfully by the
controller, isindicated by flashing all LEDs on one time.

6. Instead of pressing SW3, users can press SW4 to determine the status of the selected board'slight.
If the statusis received successfully by the Lighting Controller, the first two LEDs are turned on
and the last LED indicates the status (on/off). If either the remote acknowledges or status is not
received by the Lighting Controller, all the LEDs blink on/off several times. After any completed
operation, the Lighting Controller automatically returns to the low-power state. The program
assumesthat all LEDs are connected to the same PORT. Thetarget platform may be selected in the
pub_def.h file. Many application specific details are located in the in remote_controller.h file.

7.2  Lighting Device Selection and Operation

This section demonstrates how the board loaded with the Lighting_demo_device application isused asthe
Lighting Device.

On power-up or reset, the LEDs cycle for one (1) second to indicate that the board is a Lighting Device.
Next, the group number (i.e. SERNUM) LED flasheson for one (1) second to identify the group. Then the
board pauses and waits for the operator to select a desired channel by pressing the corresponding push
button. The selected channel flashesthe LED on for one (1) second. The board again pauses and waits for
the operator to select the desired device number by pressing the corresponding push button. The selected
device number flashes the LED on for one (1) second and initialization of the board as a Lighting Device
is complete.

To usethe Lighting Device, any push button may be pressed to toggl e the status of the corresponding LED.
Thisisfor local control. If addressed (and if the SERNUM matches), the Lighting Controller may request
that any LED be toggled, or the Lighting Controller may request the status of an individual LED. The
Lighting Device retransmits any data received and intended for another device within the SERNUM
grouping, acting as arepesater. The Lighting Device has a unique “group” number (i.e. SERNUM) and
device number (i.e. DEVICE_NUM). The program assumes that all LEDs are connected to the same
PORT. The target platform may be selected in the pub_def.h file. Many application specific details are
located in the 1ighting_demo_device.h file.
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8 Test Mode Application

The Test Mode application is an easy way to test the RF performance of the transmitter for basic
transmitter tests. The Test Mode application is a collection of test modes that consist of the following:

o lde

e TX 9th Order Binary Polynomial (PRBS9)

« RX_ON

e TX_ON with modulation

e TX_ON Continuous Wave (CW) without modulation

These tests allow for basic RF characterization of the transmitter. To start the test, perform the following
steps:
1. The Test Mode application must be generated by BeeKit as described in Section 2.3, “ Generating

an Application in BeeKit”. Import the generated .xmi fileinto CodeWarrior and generate the .mcp
file as described in Section 2.4, “Loading Applications Into a Board Using the BDM”.

2. Download the appropriate target image by following the procedure in Section 2.4, “Loading
Applications Into a Board Using the BDM” with the Test Mode App.mcp into one board.

8.1 Test Mode Application Operation

Out of reset, the board is waiting for either a channel selection via SW2 as described in Section 3.3,
“Changing the Frequency of the Board” or waiting for SW1 to be pressed to cycle through the various
modes. The modes are as follows:

* Model—Idle

* Mode 2 — 9th Order Binary Polynomial (PRBS9)
e Mode3—RX_ON

* Mode 4 — TX with modulation

* Mode5— TX with modulation off (CW mode)

By default, the mode is displayed on the LEDs after SW1 is pressed for thefirst time. If SW1is pressed
and theradio isin Mode 5 the application wraps the mode back to Mode 1.
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8.2  Spectrum Analyzer Captures

The measurements shown in this section are example illustrations only and were captured from a SRB
using the F-antenna. These measurements are radiated measurements and not conducted measurements.

8.2.1 Test Mode 1 (Idle Mode)

The Idle M ode captures the noise floor as shown in Figure 31.

% Agilent 12:59:16 Mar 8, 2006
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Figure 31. Spectrum Analyzer Capture (Idle Mode)

8.2.2 Test Mode 2 (PRBS9)
This mode captures the 9th Order Binary Polynomial as shown in Figure 32.

The capture shown in Figure 32 is set to an average of 16 frames. Averaging isturned off, so the spectrum
analyzer trace has discontinuities and the response as shown, is less than smooth.

i Agilent 13:01:30 Mar 8, 2086

Figure 32. Spectrum Analyzer Capture (PRBS9 Mode)
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8.2.3 Test Mode 3 (RX_ON)

Figure 33 showsthe RX_ON Test Mode. Because the radio isin receive mode, their islittle or no energy
captured in the 2.4 GHz band.
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Figure 33. Spectrum Analyzer (RX_ON Mode)

8.2.4 Test Mode 4 (TX With Modulation)
Figure 34 shows transmitting with modulation.
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Figure 34. Spectrum Analyzer (TX with Modulation)
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8.2.5 Test Mode 5 Transmit Without Modulation (CW Mode)
Figure 35 shows Continuous Wave (CW) Mode.
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Figure 35. Spectrum Analyzer Capture (CW Mode)
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9 Repeater Application

The Repeater application repeats al the messages received in a specific channel in order to extend the
range of a Point-to-Point link. The Repeater application is configured through the board’s UART port to
determine the working channel, the output power, and statistics about packets received and repeated.

9.1 Downloading the Repeater Application

1. Generate the Repeater application using BeeKit using the procedure described in Section 2.3,
“Generating an Application in BeeKit”.

2. Import the .xm1 file generated by BeeKit and create the .mcp file as described in Section 2.4,
“Loading Applications Into a Board Using the BDM”.

9.1.1 Compiling the Application

To compile the Repeater application, perform the following steps:
1. From the IDE window, click on the Build button to compile the application.

2. After clicking on this button, the specific .s19 file for the chosen target is generated in the
following directory:

<Solution folder>\<Project folder>\bin
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9.1.2 Downloading the Code into the Application

To download the Repeater application code, follow the steps as previously stated in Section 2.4, “Loading
Applications Into a Board Using the BDM”.

To download code into the Repeater application for Embedded Bootloader targets, follow the instructions
as described in the Simple Media Access Controller (SMAC) User’s Guide (SMACRM).

9.2 Repeater Functionality

Prior to evaluating the Repeater application, the following hardware and software are required.
* A serial cablethat connects a PC to the board.

* A HyperTerminal program or another compatible communications software opened and
configured for serial communications using the following parameters:

— 8Bits

— No Parity

— 1Stop

— 38400 Baud

— Ensure that the Append line feeds to incoming line ends option is selected.
1. Turnon the board and the following menu appears on the PC display:

—————————————— Repeater Application V0.0 —-—-—-——————————-
<s> Show Statistics:
<0> Reset Statistics:
<r> Repeat menu
<m> Switch Repeater mode:
<p> Change Power:
<d> Change Delay length:
<c> Switch Channel:
<z> EXECUTE
2. To perform the following action, press the appropriate key.
s— Pressing this key shows the current Repeater statistics
0 — Pressing this key resets the current Repeater statistics
r — Pressing this key re-displays these key options
m — Pressing this key toggles the operating mode as follows:
Dummy Mode [immediate TX]
Normal Mode [wait then TX]
p — Pressing this key scrolls through the configured power output
¢ — Pressing this key scrolls through the current channels
d — Pressing this key sets the time to wait before transmit when running in Normal Mode

z — Pressing this key starts and stops the Repeater application
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3. After choosing one of these options, pressthe“z” key to start and stop the Repeater application as
needed. All datareceived on a specific channel is sent and displayed through the UART interface
and appears on the PC display that is running the HyperTerminal or other appropriate
communications program.

Asshown in Figure 36, users can verify if the Repeater application isworking by setting up atest
using two boardsthat are physically set far enough apart so that they can not actually communicate
with each other. (The Range Demo Plus application can be used for thistest. See AN3231 for a
description of the Range Demo Plus application.) Use athird target that is running the Repeater
application, power it up, and physically placeit in range of both of these boards. Both boards
should start normal communication once the board running the Repesater applicationis set in place.

o0ard Running
Range Demo Plus < — _

~
~

~
~ Out of Range
\(No Repeater)
AN
AN
oard Running \
Repeater Application \
In Range
(With Repeater) \

Board Running
Range Demo Plus

Figure 36. Repeater Application Test Setup

NOTE

Freescale recommends using only one hop for message re-transmission to
avoid connection problems. Using more than one hop can lead to connection
problems due to high latency.
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10 Simple Protocol Test Client (SPTC)

The SPTC application allows users to test the SMAC primitives by sending specia data frames through
the Serial/USB port. The SPTC application requires two boards and the appropriate Python scriptsto
communicate with the boards or aserial port packet generator. Users can devel op their own serial program
to communicate with the SPTC by reviewing the protocol located in the spTc.xls file.

NOTE

The Freescale Embedded Bootloader is not available in this version of the
SPTC application.

10.1 Downloading the SPTC Application
1. Generate the SPTC application code using BeeKit as described in Section 2.3, “ Generating an
Application in BeeKit”.
2. Import the BeeKit generated .xmi file and create a .mcp file as described in Section 2.4, “Loading
Applications Into a Board Using the BDM”.
3. Ensurethat the BDM debugger is already connected to the PC and the board and that the
appropriate drivers are already installed.

4. Back in the Project window, click the Download button (Figure 37) and the ICD-Connection
Manager window appears as shown in Figure 38.

£

Figure 37. Download Button

ICD - Connection Manager
'rou have selected to display this dialog on startup. Specify communications
parameters and click OK.
Connection port and Interface Type
Interface: [USB HCS0B/HCS 12 Muliink - LISB Part [ LR
FRefresh List
Port: [USE-ML-12 Rev B on USB1 Mame=PE50TE379) [Autodetected) =
Interface Detected Firmware Yersian - Sacket Programming Adapter Settings .. ‘
Target CPU Infarmation
CPU: HCSD8 Processor - Autodetect
MCU reset line: MCU Yaltage:

Feset Delay

[ Delay after Reset and before communicating to target for 0 miliseconds [decimal]
W When initiating a debugaer reset, the MCU Reset Pin should be used [ele use a debug module reset)
Cyclone Pro Power Relay Control  [Waltage > Power-Out Jack}

r

—
r Fr_d =

! Connect | Hotsync ‘ Abort |
Figure 38. ICD - Connection Manager Window

5. Select the appropriate Interface from the drop down menu. Thisisusually the USB Port.

6. Select the appropriate Port from the drop down menu if multiple BDMsare connected to the system
and click on the Connect button.
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7. The Status window appears as shown in Figure 39. This window shows the download progress if
the connection is working.

1 CPROGHCS08 Programmer - Version 1.37 - [Status Window] (=]
X Abort | Tt 2wy pemicra.com

Mindows NT detected.
ICopyright 1999,2002 P&E Microcomputer Systems,Inc.

(CMD>RE
USB HCS08/HCS12 MULTILINK detected - Flash Version 5.49
Initializing. Target has been RESET and is active.

ICMD>CM D:\Program Files\Freescale\CW08 V5.0\prog\P&E\3508GBE0.S8P

USB HCS08/HCS12 MULTILINK detected - Flash Version 5.49

Initializing. (Recommended Trim = SAC) (Bus Freg = 15546KHz) Initialized.
;version 1.06, 11/22/2004, Copyright P&4E Microcomputer Systems, www.pemicro.com
;device Freescale, 6BHCSS08GBe0D, AlL

‘begin_cs

Loading programming algorithm ...

Running prosramming script

Figure 39. Status Window

8. After the code is downloaded to the target, the system is running in Debugger Mode and the
Debugger application window appears as shown in Figure 40.

B True-Time Simulator & Real-Time Debugger D: g y C\SMAC temp's... |- |(OJES
File View Run MultiinkCyclonePro Component Memory Window Help
Ol 452 2% e[|« 2
- +
6l Source ~JEIEd | @l Assembly =\
D-\Proflestugaichiy Doouments\APDLSoftwarch SMAC\EMAL temphSMACA. |Line: 288 Startup
2) initialize run-time, ... [il 9278 SEI [:I
initialize the copy down init dat etc 927C LDA 0x928F
3) call main; 927F BIT #0x02
called from: PRESTART-code generated by the Linker 9281 BNE *+6 rabs = 0x9287
* 9283 LDHK  $0x0E07 3
4ifdef _ELF_OBJECT FILE_FORMAT _ 9286 TXS
DisableInterrupts; /* in HIWARE format, this is done in the 9287 BSR *-121 ;abs = 0x920E
#endif - 9289 LDEX  0x9230
for (;;) {El /* forever: initialize the program; call the roo=| 4l
+f {!(_startupData.flagasSTARTUE_FLAGS NOT_INIT_SB)) (B [y] i =]
m
"iLl () ,|/Hesos | Auta
T Procedire = || S
HX o SP e
I s [e8 status [vAINZC
|_Startup () BC |927B
r =
B Data: 1 - o] | = Mmemory =J=]
T StartlE. = Ao | Sk | Gebdl ||| [ futa
_startuplata <9> _tagStartup 0080 00 8A FF BE 00 00 AC 20
__SEG_END_SSTACK <0> array[0] of unsigned char 0088 00 01 AC 87 8l Fé AE
0090 08 SE E2 03 48 24 02 A8 .. .-
8 07 5A 26 F8 9E E7 03 88 .
loan ea 65 vr rr ar 01 g6 Ra e e
E |
[ pata:2 sillE c nd
[ |_Startup. Auto Symb | Local
10 registers loaded fo
Startup command file d [;I
Preload command file does not exist.
Postload command file does not exist. [ll
Em] (2]
For Help, press F1 ‘Aubumatlc (triggers, breakpaints, watchpoints, and trace possible) 9508GBE0 ICD [Targe @

Figure 40. Debugger Application Window

9. Either disconnect the BDM cablefrom thetarget board and pressitsreset button or run the program
on the target via the debugger session by clicking on the Run button (Figure 41).

nlwa| k=2 2[e|(2le=(<le]+] 2|
Figure 41. Debugger Run Button

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1

Freescale Semiconductor 33



) 4

10.2 Testing the SPTC with the WirelessUART
Download the SPTC application to a board that will be the tester.
Download the WirelessSUART application to a board that will be the subject of the test.

Open aHyperTerminal session (or another compatible communications program) and configure it
for serial communications using the following parameters:

1.
2.
3.

38400 Baud
No Flow control

Connect the board that is running the WirelessUART application to the serial port of the PC and
press that board’ s reset button. A message appears on the PC display as shown in Figure 42:

@ WirelessUart - HyperTerminal 2o
File Edit nsfer  Hel

Yireless Typematic Demo

Connected 0:00:05 Autodetect  384008N-1 O

Figure 42. WirelessUART Message

5. Open the Freescale Test Tool located in the following directory:

Programs/Freescale ZigBee/Test Tool

6. Asshown in Figure 43, from the Test Tool window, select Tools -> Communication Settings.

i Test Tool m =]

Fie View |Tools Window Help

Change communication settings [Thom [ 2
Figure 43. Communication Settings in Test Tool
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7. Asshownin Figure 44, for the board that is running the SPTC application, create a new seria
connection. Select the appropriate Comport and set the baud rate at 19200. Click the OK button

Zghee |
(% Seral

Comport: comi| =

Baudrate: 15200 -

~ ¢ USB-BDM

BOM Tupe: -

~ " WinSocket:

Address:

Port: 1241 -

oK | Ganedl | el |
Figure 44. Test Tool Device Settings Window

8. TheList of Devices window appears as shown in Figure 45. Disable all connections except the
SPTC connection that was just created by highlighting the connection to be disabled, and clicking
on the Disable button. The disabled connections are grayed out.

List of Devices =

Mame | Location | Type | Add Intemal..

ZigBes COMS [19200] 10002 ZigBee Device Add External |

ZigBes COM15 [15200] 10003 ZigBee Device =

EMOve |

Settings... |

Rename |

Move Up |

Move Down |

Figure 45. Enabling and Disabling Connections

9. Asshown in Figure 46, use the Test Tool main menu to open the Script Server application by
clicking on View -> Script Server.

e Test Tool nE=]

Fic |View Tools Window Help

Command Consale
Embedded Bootloader

[ homl 4
Figure 46. Launching the ScriptServer

Show or hide Script Server
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10. The Script Server window appears as shown in Figure 47. Load the
sendingletterstotheWirelessUart.py Python script, which islocated in the following directory:

~\<Solution Name>\<Project name>\Sources

Test Set/Gcrpts

Selected tem % Display Test Resuits [ Display

estamp

e Towser e
o Bt nciee r RESULTLOG b
4 Search for Test Case’ Scripts - and Test Set’ Files ]
| ok [Soews =] «@cfE-
[siEseild Sending letters to the Wireless Uart(MAX P
A #]Sending letters to the Wireless Uart(: ower).py
SumEE @ 9 JSending lattars to the Wirsless Usrt py
Failed 0 MyTecernt =) zgevent.py
| | Dosarerts|[2)igui.y
4. Fomovoal A
e
e oL =
evice packets e #
FC < Deviceackets: | pghoacionr
P Packets: 0 &
5 [sendng etersto e e Uonpy ] =
Hiles of type: Script/Test Case Fies ("py:"tst) L LT
¥ Open asreaconty

Figure 47. Loading the Script

11. As shown in Figure 48, click on the Execute button to run the script.

Lo

¥ Disply Test Resuts [ Display Timestamp.
I SaveRestsnFie JRESULTLOGM

o setup|
P4 Remove A Search Path

SetUpSeschpaths |
F5 Loa/Ed

o: [GCRIPTLOGM

FC < Devics packets Cloar 3
FoXPackets: 0

TXPackets: 0

7 Displey T Packets

7 Displey FiX Packets

Tosl Cammand/everts
c [

Events - 0
¥ Display TookCommands
¥ Dislay TooEverts

Figure 48. Running the Script

12. Onthe PC that isrunning the HyperTerminal application and is connected to the board running the
WirelessUART application, the expected end result is shown in Figure 49. If thisis not the end
result, try running the WirelessUART application on the SPTC again.

& erer - HyperTerminal | =]
e Edt Vew Cal Transter fel
b= & DB &

ABCDEFGHIJKLMNOPQRSTUVWRYZABCDEFGHI JKL MNOPQRSTUVHRYZABCDEF GHI JKL HNOPQRSTUVHXYZAB
CDEFGHIJKLMNUP[JRSTUVHHVZHBCDEFGHIJKLMNUPURSTUVNHVZHBCDEFGHIJKLMNUPURSTUVHKVZHBCD

TJKLMNOPQRSTUYHKYZABCDEFGHTJKL MNOPQRS TUVWHYZABCDEF GHI JKLMNOPQRSTUVHXYZABCDEFGHI J
KLMNOPQRSTUVHKYZABCDEF GHI JKL MHNOPQRSTUYHKYZABCDEFGHTJKLMNOPQRSTUVWKY ZABCDEFGHT JKL
MNOPQRSTUVWXYZABCDEFGHT JKL MNOPQRSTUVWXYZABCDEF GHI JKL HNOPQRSTUYHXYZABCDEFGHT JKLMN
OPQRSTUYHXYZABCDEFGHIJKLMNOPQRS TUYWKYZABCDEFGHIJKLMNOPQRSTUVHKYZABCDEF GHIJKL HNOP
QRSTUYHKYZNABCDEF GHI JKL HNOPQRS TUYWXYZABCDEFGHIJKLMNOPQRSTUVHXYZABCDEF GHI JKL MNOPQR
STUVWKYZNBCDEFGHT JKL MNOPQRSTUVHKYZABCDEF GHT JKL MNOPQRSTUYHHYZABCDEFGHT JKLMNOPQRST
UVHKYZABCDEFGHIJKLMNOPQRS TUVHWHY ZABCDEF GHI JKL MNOPQRSTUYHXYZABCDEF GHI JKL MNOPQRSTUY
WHYZABCDEF GHI JKL MNOPQRSTUYHXYZABCDEFGHIJKLMNOPQRS TUVWHYZABCDEFGHIJKL MNOPQRSTUVHE
VZHBCDEFGHIJKLMNUPURSTUVHNVZHBCDEFGHIJKLMNUPORSTUVHHVZHBCDEFGHIJKLMNUPURSTUVNHVZ
ABCDEFGHIJKLMNOP! ZABCDEFGHI JKLM RSTUYHKYZABCDEF GHI JKL MNOPQRSTUYHKYZAB
CDEFGHIJKLMNUPORSTUVHHVZHBCDEFGHIJKLMNUPURSTUVNHVZHBCDEFGHIJKLMNUPURSTUVHNVZHBCD
EFGHIJKL MNOPQRSTUVHKYZABCDEF GHI JKL MNOPQRS TUVWXYZABCDEFGHI JKLMNOPQRS TUVWRYZABCDEF
GHIJKLMNUPURSTUVNHVZHBCDEFGHIJKLMNUPURSTUVHKVZHBCDEFGHIJKLMNUPURSTUVHHVZHBCDEFGH
TJKLMNOPQRSTUVHRY. OPQRS ZABCDEFGHIJKL MNOPQRSTUVHKYZABCDEFGHIJ
KLMNOPORSTUVHKVZHBCDEFGHIJKLMNUPORSTUVHHVZHBCDEFGHIJKLMNOPORSTUVNHVZRBCDEFGHIJKL
MNOPQRSTUVWXYZABCDEFGHT JKLMNOPQRSTUVWXYZABCDEF GHI JKL HNOPQRS TUYHXYZABCDEFGHT JKLMN
UPGRSTUVHHVZHBCDEFBHIJKLMNUPURSTUVNHVZHBEDEFGHIJKLMNUPURSTUVHKVZHBCDEFBHIJKLMNUP
URSTUVHXVZHBCDEF OPQRS YZABCDEFGHIJKL MNOPQRS YZABCDEFGHI JKLMNOPQR
STUVWHYZABCDEFGH KLMNUPURSTUVHXVZHBCDEFGHIJKLMNUPORSTUVHHVZHBCDEFGHIJKLMNUPURST
UYHXYZABCDEFGHIJKLMNOPQRSTUVHRYZ

Disconected Autodetect 38400 8-N-1 M

Figure 49. WirelessUART Expected Result
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11 Over the Air Programmer (OTAP)

The Over the Air Programmer (OTAP) isbeneficial in wireless applications when physical connectionsto
existing installations are costly, inconvenient or impossible. The OTAP application allows usersto update
FLASH remotely without a physical connection.

Given an OTAP enabled application and an OTAP programmer, users can replace an existing application
with anew application. For the OTAP application, users will utilize two boards; one board will be the
programmer (OTAP Programmer) and the other board (OT AP-enabled board) will have its firmware
updated. It is recommended that both images be an OTAP-enabled application.

The following summarizes what users will accomplish with the OTAP application:

» OTAP Programmer Board:
— Download and run the OTAP Programmer software
— Download an OTAP-enabled application viathe UART
— OTAP Programmer boards include the 13192-NCB and the Axiom-0308 with the
MC1320x/MC1319x RF Daughter Cards.
» OTAP-enabled application Board (board having its firmware updated):
— Download and run the OTAP-enabled Accelerometer application on the board that will have
its firmware updated.

— An OTAP enabled board can include any of the boards listed in Section 2.1, “ Supported
Hardware”.

In the following subsections, userswill download the WirelessUART image from the OTAP Programmer
board to the OTAP-enabled board that was previously running the Accelerometer application. Both
Wireless UART and Accelerometer images must have the OTAP module property enabled when the
project is generated in BeeKit.

NOTE

All SMAC applications support OT AP except the applications that run both
the Embedded Bootloader and the OTAP Programmer. As stated, the only
two target boards that can run the OTAP Programmer software are the
13213-NCB and the Axiom-0308 with the MC1320x/MC1319x RF
Daughter Cards.
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11.1 Downloading the OTAP Programmer Software

This section describes how to download the OTAP Programmer software to the board that will be used as
the OTAP Programmer.

1.

Generate the OTAP Programmer code using BeeKit as described in Section 2.3, “Generating an
Application in BeeKit”.

Import the OTAP Programmer .xmi file and generate the .mcp file according the procedure
described in Section 2.4, “Loading Applications Into a Board Using the BDM”.

Ensure that the BDM debugger and the OTAP Programmer board are connected to the PC.
Compile the target in the project by selecting the Compile button (Figure 50).

&

Figure 50. Compile Button

Back in the Project window, click on the Download button (Figure 51) and the ICD-Connection
Manager window appears as shown in Figure 52.

%

Figure 51. Download Button

ICD - Connection Manager

“ou have selected to display this dialog on startup. Specify communications
parameters and click OK.

Connection port and Interface Type

Interface: |LISE HCS0B/HCS 12 Mulliink - USE Fort =l Add LPT Part
Refresh List

Poit: |USB-ML-12 Fev B on USE1 [Name=PES016379) [Autodetected] j

Interface Detected : Firmware Yersion Socket Programming Adapter Settings |

Target CPU Information
CPU: HCSDE Processor - Autodetect
MCL reset line: MCU Yaltage:

FRezet Delay
™ Delay after Resst and before communicating to target for 0 millizeconds [decimal).
v when initiating a debugger reset, the MCL Rezet Pin should be uzed [else uze a debug module reset]

Cyclone Pro Power Relay Control  [Woltage - Power-Out Jack}

r =
- =l =

(i EEp= | Abion |

Figure 52. ICD - Connection Manager Window

Select the appropriate Interface from the drop down menu. Thisis usually the USB Port.

Select the appropriate Port from the drop down menu if multiple BDMsare connected to the system
and click on the Connect button.

The Status window appears as shown in Figure 53. This window shows the download progress if
the connection is working properly.
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1 CPROGHCS08 Programmer - Version 1.37 - [Status Window] =Jo&d

X Abort Irufilygs -f sy _premmicro.conn
Windows NT detected.
ICopyright 1999 ,2002 P&E Microcomputer Systems,Inc.

ICMD>ERE
USB HCS08/HCS12 MULTILINK detected - Flash Version 5.49
Initializing. Target has been RESET and is actiwve.

ICMD>CM D:\Program Files\Freescale\CWO8 WV5.0\prog\P&E\9S08GB60.S8P

USE HCS08/HCS12 MULTILINK detected - Flash Version 5.49

Initializing. (Recommended Trim = SAC) {(Bus Freq = 15546FKH=z) Initialized.
;version 1.06, 11/22/2004, Copyright P&E Microcompunter Systems, www.pemicro.com
;device Freescale, G6BHCSS908GB6D, All

:begin_cs

Loading programming algorithm ...

Fuaning programming script ...

Figure 53. Status Window

9. After the code is downloaded to the target, the system is running in Debugger Mode and the
Debugger application window appears as shown in Figure 54.

8, True Time Simulator & Real Time Debugger D 8 y CsMAC temp's.... (= (023
Fle View Run MultlinkCydonePro Component Memory Window Help

i =T T A -»|2r|=|1.r:|er|-||3”

5] Source ™= [&] Assembly -
[D:\Profileshrad04ciMy DocumentssRPDAS oftwars\GMACLSMAL tempsSMACH. |Line: 265 |_Startup.
2) initialize run-tims, ... b 9278 SEI b
initialize the RAM, copy down init dat etc 927C LDA 0xr928F
3) call main; 927F BIT #0x02
called from: _PRESTART-code generated by the Linker 8281 BNE *+6 ;abs = 0x8287
*/ LDHX #0x0EQ7 =
fdef _ FLF OBJECT FILE FORMAT _ THS
DisableInterrupts; /* in HIWARE format, this is done in the BSR *-121 ;abs = Ox3920E
#endif — 9289 LDHX 0x9290
for (:3) ([ /+ forever: initialize the program; call the rool=| I 8l
1f (! (_starcupbata.flagssSTARTUE_FLAGS_NOT_INIT_SB)) [E [y e olb3
m
"i]—‘ ) |/nesos | [ Aue
[l Procedure = 2 °
HX o sp| EF
‘ SR 68 Status | VEINZC
|_Startup () BC |927B
9 —
Bl Data:1 _ [0l = Memory
f Starl8.c [Aute [ Symb  [Global || [
_startupData <9> _tagStartup (0020 00 2A FF BE 00 00 AC 20
__SEG_END SSTACK <0> array[0] of unsigned char (0028 00 01 AC 87 8B 89 Fé AE

0090 02 9E E2 03 48 24 02
0098 07 S2 26 Fe 9E E7 03 28 .
lnnan 65 _FF_FF_AF 01 26 Fi

Data:2 = d
[ [_Startup [ute | Symb [ Local
I0 registers loaded for MC95S08GB6E0 from
Startup command file does not exist. El
Prelead command file does not exist.
Fostload command file does not exist. |V
[<inl )
For Help, press F1 |automatic (riggers, breakpaints, watchpaints, and trace possible) 95086860 fIco [Targe 4|

Figure 54. Debugger Application Window

10. Either disconnect the BDM cable from the OTAP Programmer board and pressiits reset button, or
run the program on the target via the debugger session by clicking on the Run button (Figure 55).

NE TR IRy
Figure 55. Debugger Run Button
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11.2 Downloading an OTAP-enabled Image to the OTAP Programmer
Board

This section describes how to download the Wireless UART application to the OTAP Programmer board.

1. Open the HyperTerminal or Tera Term configuration file contained in the following OTAP
Programmer directory:

~\<Solution Folder>\<Project Folder>\Sources\OTAP.ht

2. Asshown in Figure 56, use the following settings to manually configure HyperTerminal:
— 8 DataBits
— No Parity
— 1 Stop
— 19200 Baud
— Flow control hardware
— Send line ends with line feeds
— 1 millisecond delay between characters

COM1 Properties B[x]
Port Seftings Connect To | Settings
Function SAGEq Setup E]
i ©Te i
Bite per second: | 16200 o SRR g
Backsp4 Send line ends with line feeds
vasis A = @ i+ Echo typed charactsrs locally
Bt Line delay: 0 milliseconds.
Parity: | None v ANSI Character delay: |1 miliseconds
it Telnet t
Stop bits: | 1 ] e ASCII Receiving
Backseroll Append line feeds to incaming line ends
Rewtorl? | Hanhive bt [ Play sof [ Force incoming data to 7-bit ASCII
Wrap lines that exceed terminal width
Restore Defaults Input
=

Figure 56. Manual Hype'rTerminaI Configuration

3. Turn on the OTAP-Programmer application board.

4. PressButton 1 on the OTAP Programmer board to select the UART mode. Wait for the menu to
appear on the HyperTerminal window as shown in Figure 57.

@ OTAP - HyperTerminal B@

File Edit View Call Transfer Help

O = & =B

******* OTAP Programmer v1.8 -———————

<f> Find OTAP enabled devices [
<s> Selected device [
<p> Change Power [
<c> Change Channel [
<d> Download Image

<r> Repeat menu

Ready>

Connected 0:00:22 ANSI 19200 8-4-1 NUM

Figure 57. OTAP Menu in HyperTerminal Window
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5. AsshowninFigure 58, press'd' to download the WirelessUART image to the OTAP-Programmer
board.

‘ @5 OTAP - HyperTerminal || (=) |

File Edit wview Call Transfer Help

D & 3 0B
——————— OTAP Programmer vl . 8 ——————— [~

<f> Find OTAP enabled devices [
<s> Selected device [
<p> Change Power [
<c> Change Channel [
<d> Download Image

<r> Repeat menu

Ready> d
Please send $19 file as a text file

Waiting. ..

Connec ted 0:00:09 ANST 19200 §-N-1 NUM

Figure 58. OTAP Download Image Window

6. Send theimage as atext file by selecting Transfer -> Send Text File, as shown in Figure 59.

| @ OTAP - HyperTerminal [ =.(r=1[<]

File Edit WView Call Transfer Help

O = B ol sendFile.. |
Receive File... |

_______ 0TI capture Text... | e

N | SendTextFile... | .

<f> Find 0O svices [B]

<s> Selectd Septurewmprnter | [ 1

<p> Change Power [15

<c> Change Channel [15

<d> Download Image

<r> Repeat menu

Ready> d
Please send 819 file as a text file

Waiting. ..

— ~
Sends a text file to the remote system

Figure 59. Sending the OTAP Image as a Text File

7. Configure the Send Text File window to look for all file types as shown in Figure 60.

Send Text File B3
Look in: | I bin ~] & % = m-
N @ wireless_uart_13213_SRB.abs
“) = wireless_uart_13213_SRE.abs.s19
My Recent i wireless_uart_13213_SRE.map
Documents wireless_uart_13213 SRB.S519
Fr “%
Desktop
My Documents
2
i
My Computer
RGDD4Con R... |
€)  Aeome: v
»
My Network Files of type: Al files %) | Cancel

Tent file . TXT)
All files )

Figure 60. Setting the Send Text File Window to Look For All File Types

8. Searchfor theimagefile (inthisexample, thewireless_uart_13213_srB.S19) inside the bin folder
of the OTAP-enabled Wireless UART application. Compile the Wireless UART example as
follows:

a) Use BeeKit to generate the Wireless UART application with the SMAC/OTAP Enabled
property set to True and a specific string in SMAC/OTAP ID property.

MC1319x, MC1320x, and MC1321x Demonstration Operation Application Note, Rev. 1.1

Freescale Semiconductor 41



b) Import the WirdlessUART .xml1 file and generate the .mcp file following the steps described in
Section 2.4, “Loading Applications Into a Board Using the BDM”.

¢) Compilethetarget and Build All in the SMAC project by clicking on the Compile button.
d) Compilethetarget to usein the WirelessUART project.
As shown in Figure 61, this example loads the wireless_uart_13213_SrB.S19 file.

3 D:\Profilesirgd04c\My Documents\RPD\Software\SMAC\SMAC temp\SMACA. 2\508\apps\OTAPExample-Wirele | |(01/E4
T

File Edit View Favorites Tools Help

G Back - (g ir p' ﬁ( /- ) search Folders Elv

: Address \SMAC4, 21508 \apps\OTAPExample-Wireless Uart\3. 1\bin v a Go
MName Size | Type Date Modified
File and Folder Tasks 2 wireless_uart_13213 5RB,abs 153KE  ABS File 8/1/2006 5:00 PM
@ wireless_uart_13213_SRB.abs.s19 15KB S19File 8f1/2006 5:00 PM
Other Places ¥ wireless_uart_13213_SRE.map 87KB MAP File 8/1/2008 5:00 PM
m 15KB S19File 8/1/2005 5:00 PM

Details ¥

Type: 519 File
Date Modified: 8/1/2006 5:00 FM
Size: 14.4 KB

Figure 61. Selecting the S19 File

9. Asshownin Figure 62, wait for the image to transfer until the following message appears.

Would you like to update NV-RAM? Yes(y) No(n)

10. When prompted to update NV-RAM, press'n' (No) to return to the previous menu. The NV-RAM
update feature is not currently available.

‘@

e 538 0B

$123A9602044656D6F 202055 106461 146564200665 12 136961 6E20316DBDBBLEGD 12066086 e
812319806561 74 757265 13300D2D466561 74 75 126520310D2D466561 74 15 1265203200209 1
$123N9N04275672046697820310D000D4F544158204D6F64 756C6520646562 756 70D00BADS
$118A9CO100300201F3C41646472303030317236353022000055

S104FFBF023B
S123FFCCIF089FO8IF08IF08IF08A154 9FBEIFB8ALS4 IFBBIF 86IF0BIFBEIF08IFBEIF 0885
gééggzggEEBS9F@89F889F889F@89F@89F@898869F88947898

Application name: wireless_uart_13
Image Sucessfully received
6844 Bytes Received

Hould vou like to update NV-RAM? Yes(y) Noln) _

Connected 0:27:21 ANST 19200 8-N-1 NUM

Figure 62. Image Download Complete

NOTE

The download process may take several minutesto complete. It can take as
long as 3 to 5 minutes depending on the image size. Thisis normal
operation.
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11.3 Downloading the OTAP-enabled Accelerometer Application
This section describes how to download the Accelerometer Application to the board that will have its
firmware updated by the OTAP Programmer.

1. UseBeeKit to generate the Accelerometer application with the following SMAC property settings;
OTAP Enabled property set to True and a specific string in OTAP Default 1D property field as
shown in Figure 63.

i d E3lze

| OTAF Enabled True |
Embedded Bootloader Enabled False
Promiscous Mode Falze

OTAP Default |D

Security Type SEC_MODE_SIMPLEXOR o
Securty Default KEY "555505" -

Figure 63. BeeKit SMAC-OTAP Enabled and OTAP Default ID Property Settings

2. Import the Accelerometer .xml file and generate the .mcp file following the steps described in
Section 2.4, “Loading Applications Into a Board Using the BDM”.

3. Compilethetarget and Build All in the SMAC project by clicking on the Compile button.
Compile the target to use in the OTAPWirelessUart project.

5. Click on the Download button and follow the steps already described, starting with Step 5in
Section 11.1, “Downloading the OTAP Programmer Software”.

>

11.4 Transmitting New Image to an OTAP-enabled Board

This section describes how to send an image to an OTAP-enabled board using the LCD Interface on the
OTAP Programmer board.

1. Turnonthe OTAP programmer board and download the image to that board using HyperTerminal
or Teraterm as already described in Section 11.2, “Downloading an OTAP-enabled Image to the
OTAP Programmer Board”.

2. Onthe board that will have its image updated and currently has the Accelerometer application
loaded, enable its OTAP mode by pressing and holding Button 1 during a reset.

3. Reset the OTAP Programmer board by pressing its reset button. After reset, but before pressing
any buttons, the LCD on the OTAP Programmer will display the following:

OTAPSW v.1.0
[UART|LCD** [**|

4. Onthe OTAP Programmer board, press LCD (Button 2) to select the LCD interface. Before
pressing any buttons again, the LCD on the OTAP Programmer will display the following:
wireless uart_13
[FIND[*****|CS
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10.

11.

NOTE
The“wireless uart_13” text shown in this example will change according
to the name of the project.
Press FIND (Button 1) to start finding OTAP-enabled devices. Before pressing any buttons again,
the LCD on the OTAP Programmer will display the following:
FINDING... 01
[IDONE|ESCJ** [**|

NOTE

The number shown in the upper right corner of the LCD display will change

according to the number of devices found.
Press DONE (Button 1) to stop looking for devices. Before pressing any buttons again, the LCD
on the OTAP Programmer will display the following:
OTAPDEVICES 01
|[FIND|SEL|**|CS|
Press SEL (Button 2) to select the device that was found. Before pressing any buttons again, the
LCD on the OTAP Programmer will display the following:
SEL ACCELO01 ?
|OK [ESCl<<[>>[*---
Press OK (Button 1) to select the device. Before pressing any buttonsagain, the LCD onthe OTAP
Programmer will display the following:
ACCELO01 SEL
|FIND|SEL |SND|CS

NOTE

The name of the device in this example is ACCEL0O1. This name will
change according to the value assigned in BeeKit. Use the Arrows (<< >>)
on the LCD display by pressing the corresponding buttons on the board to
select any found devices.

Press SND (Button 3) to start sending theimage from the OTAP Programmer to the OTAP-enabled
board.

Wait until the countdown of the messages shows DONE. If theimage was successfully transmitted
from the OTAP Programmer to the OTAP-enabled board, the LCD will display the following:

SENDING 0/174

[IDONE|ESC]** [**|

If the image transmission failed, the LCD will display the following:
SENDING 174/174

|CANCIESC|** [**|
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NOTE

Thedisplayed number (174) will change according to the number of packets
sent.

12. If theimage transmission failed, go back to Step 2 in Section 11.4, “ Transmitting New Imageto an

OTAP-enabled Board” and try again.

11.5 Verifying the Transmitted Image
Perform the test described in this section to verify that the image was successfully transmitted.

1.

a ks~ DN

Ontheboard having itsimage updated, enable OT AP mode by pressing and holding Button 1 while
resetting the board.

Reset the OTAP Programmer board by pressing its reset button.

Press Button 2 (LCD) on the OTAP Programmer board to select the LCD interface.

Press Button 1 (FIND) on the OTAP Programmer board to start finding the OTAP-enabled boards.
Before pressing any buttons, ensure a device was found. Thisisindicated by the LCD displaying
the following:

OTAPDEVICES 01

Press Button 2 (SEL) on the OTAP Programmer board to select the OTAP-enabled board.
The LCD displays the new image previously sent to the OTAP-enabled board.

In summary, the name of the boards found will change to the ones established in the previous
configuration. For example, if userspreviously had aboard named ACCEL 001, they will now haveaboard
named UARTO0O01 using the information from the example described in Section 5.1, “Loading the
Accelerometer Application”.
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